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A.  Will you require JoVE to record video microscopy, such as filming a complex dissection or microinjection technique? (Y/N)____N_____  (If you can record images/videos using your own camera/software, then mark No)   If yes, please list make and model of your microscope: _

B.   Does your protocol include detailed, step-by-step, descriptions of software usage? (Y/N)__Y___ If yes, we will need you to record using screen recording software to capture the steps. If you use a Mac, QuickTime X also has the ability to record the steps.

C.  Which steps of your protocol will viewers benefit most from having filmed? Please list 4-6 individual steps using the step numbers listed in this document. (Please do not list entire sections.) __ Only Step 1 of the protocol requires filming, really. Filming that would give viewers an idea of the size of the specimen and how it is placed into the scanner, etc. The rest of the protocol steps are performed on the computer, they can be illustrated by showing screenshots and other images while narrating. We also have animations (videos in avi, mp4, or similar format) that can be very well used in place of still images in the video article to illustrate some specific steps. Please see video we have uploaded with the manuscript. 

D.  What is the single most difficult aspect of this procedure and what do you do to ensure success?  Please list 1-2 individual steps using the step numbers listed in this document. (Please do not list entire sections.) __ Step 3 (Data processing/Segmentation), in particular 3.1.2 and 3.2.2-3.2.3. These critical steps involve playing with software settings. However, placing seeding points in 3.2.2 as well as showing what happens when settings are incorrect may be filmed (showing what happens on the screen).____
E.  Will the filming need to take place in multiple locations? (Y/N) __N_ If yes, how far apart are the locations? ____

1. Introduction (Experimental Goal and Author Interviews) – As the beginning of your video, the introduction should clearly present the goal of your method to the viewer and its significance.  Other information can be provided according to the various statements below, but the total introduction should not exceed 150 words. 
A. Experimental Goal (read by voice talent at JoVE):
The overall goal of this procedure is to extract quantitative information on plant roots from in-soil x-ray computed tomography data. (Intro)
B.  Required Interview Statements: (Said by you on camera. Don’t forget to smile!)  
1.1. Tamas Varga: This method of investigating the root structure of live plants can help answer key questions in the biology field, such as how plants respond to changing environmental conditions like drought, microbial activities, and so forth. 
1.2. Tamas Varga: The main advantage of this technique is that it is non-invasive and it can study plants in their native environment, the soil.   

C.  Optional Interview Statements: (Said by you on camera. Don’t forget to smile!)  
1.3. Adriana McKinney: Visual demonstration of this method is valuable as the procedure involves numerous steps, including tomographic imaging, data reconstruction, and analysis, which may be obscured without visual aid.
Protocol (read by voice talent at JoVE):

2. Root Imaging
2.1. To begin, place a potted plant on the sample manipulator of the x-ray tomography scanner at a distance desired for target magnification [2.1.1-WIDE/MED].  For a plant in a 2-inch diameter holder, set a sample to a source distance of about 3 inches [2.1.2-MED/CU].
2.1.1. Talent places potted plant on sample manipulator
2.1.2. Talent adjusts the distance of the plant from the source to about 3 inches
2.2. In the instrument control software [2.2.1-MED OVER SHOULDER], set the x-ray power settings to 85 kV and 190 (A [2.2.2-SCREEN/LM].  Then set the exposure time to 1 second for a better signal to noise ratio [2.2.3-SCREEN/LM].
2.2.1. Talent sitting at computer opening software

2.2.2. Talent sets settings to 85 kV and 190 uA

2.2.3. Talent sets exposure time to 1 second

2.3. Set the number of projections to 3142 and the number of frames per projection to 4 for good data statistics [2.3.1-SCREEN/LM].  

2.3.1. Record as written
2.4. Using the scan parameters just set, select the ‘Shading correction’ tab, then click on ‘New’ and name the shading correction file, then click ‘Present’ to confirm the new conditions [2.4.1-SCREEN/LM-TXT].
2.4.1. Talent selects shading correction tab and clicks on ‘New’ and names file then clicks present to confirm new conditions (TEXT: parameters 85 kV, 190 (A, and 1000 ms are good to use); Editor, show text note for naming the shading correction file.
2.5. Next, click ‘Create’ and click ‘OK’ to using 2 reference images, then click ‘Generate’ [2.5.1-SCREEN/LM].  Then, when the ‘Warning’ pop-up window appears [2.5.2-SCREEN/LM], physically remove the sample from the beam path [2.5.3-MED/CU] before clicking ‘OK.’  The shading correction will now run [2.5.4-SCREEN/LM].
2.5.1. Talent clicks ‘Create’, OK for using 2 reference images, then clicks ‘Generate.’

2.5.2. Warning popup window appears on screen

2.5.3. Talent removes sample from beam path

2.5.4. Talent clicks OK and the shading correction runs (this may be a continuation from 2.5.2)

2.6. Now, click on the ‘Acquisition’ tab, name the data file, then select ‘None’ for X-ray filter [2.6.1-SCREEN/LM-TXT].
2.6.1. Talent clicks acquisition tab, names data file, then selects ‘none’ for X-ray filter (TEXT: Ex:  Root Imaging), Editor, insert text for naming the data file.

2.7. Ensure that the ‘Minimize ring artifacts’ checkbox is checked so that the sample will be rotated in angular steps while the projection images are acquired.  Finally, start the scan by clicking the ‘Acquire’ button [2.7.1-SCREEN/LM].
2.7.1.   Talent selects ‘minimize ring artifacts’ option then clicks Acquire button
3. Data Reconstruction
3.1. After acquiring the raw data, load it into the reconstruction program [3.1.1-MED OVER SHOULDER-TEXT].  Compare the first and last images by clicking on ‘Blink’ to make sure the specimen did not move or the scan settings did not change during data acquisition [3.1.2-SCREEN/LM].
3.1.1. Talent at computer loading raw data into the program (TEXT: ex: CT PRO 3D)
3.1.2. Talent clicks on ‘Blink’ and First and last images show up side by side on screen with cursor moving between them for as talent compares sequentially, so the footage shows clicking back and forth.
3.2. Calculate the center of rotation, or COR by selecting the ‘Center of Rotation’ tab and using options “Automatic” COR finding with “High Quality” accuracy, and “Dual” slice selection for COR calculation. Then click ‘Start’ to run the calculation [3.2.1-SCREEN/LM]. 
3.2.1. Talent selects Center of Rotation tab and uses options Automatic COR finding with High Quality accuracy and Dual slice selection.  Then talent clicks Start to run calculation
3.3. After the COR is found, click the ‘Volume’ tab to select the sample to be reconstructed.  Use the thumbnails to edit the volume selection windows.  Then click start to perform reconstruction to create the volume file containing 3D data [3.3.1-SCREEN/LM].
3.3.1. Talent selects Volume tab and uses thumbnails to edit volume selection windows.   Talent then clicks start to perform reconstruction 
4. Data Processing/Segmentation
4.1. To prepare a RooTrak processable image stack, load the volume file into ImageJ by clicking ‘File,’ ‘Import,’ ‘Raw,’ then selecting the volume file [4.1.1-MED OVER SHOULDER].
4.1.1. Talent clicks File, Import, Raw then selects the volume file
4.2. To optimize the image contrast between the root and soil, click the ‘Image’ tab, then choose ‘Adjust Brightness/Contrast’ and select ‘Auto.’  When the region of interest is visible and clear, the settings are considered optimized.  Save the images as an image stack in jpeg, bmp, or png format by clicking ‘Save as’ and choosing ‘Image Sequence’ [4.2.1-SCREEN/LM].
4.2.1. Talent adjusts contrast by clicking Image tab, Adjust Brightness/Contrast, and selects ‘Auto.’ and when ROI is clear, talent saves image in one of the formats mentioned

4.3. To process in RooTrak [4.3.1-MED OVER SHOULDER], to segment the root, select the ‘Tools’ tab and choose ‘Tracker’, then double-click on the white entry area of the dialog box to load an image stack [4.3.2-SCREEN/LM]. 
4.3.1. Talent opens RooTrak

4.3.2. Talent selects Tools tab and chooses Tracker, then double clicks on white entry area of dialog box to load an image stack
4.4. After the images are loaded, choose the ‘Tracker’ tab and set seed points inside the root by clicking several points inside each of the pertinent root sections visible in the top view slice of the volume data [4.4.1-SCREEN/LM].
4.4.1. Talent chooses Tracker tab and clicks several points inside each of the pertinent root sections visible in top view slice

4.5. Set the tracker parameter ‘Smoothness’ to 0.3 and ‘Similarity’ to 0.8.  Click the field below ‘Output Directory’ to choose a file folder, then click ‘Select Folder’ and click ‘Start.’  The tracking function will then run.  This will follow the root from the top image slice all the way to the bottom slice [4.5.1-SCREEN/LM].
4.5.1. Talent sets Smoothness and Similarity then clicks field below Output directory then clicks ‘Select folder’ and clicks ‘Start’ and tracking function runs
4.6. After opening and viewing the volume data, select the number of slices according to the usable data volume.  In the example shown here, tracking was stopped at 200 slices, equivalent to a depth of 6.2 mm, where root boundaries became ill-defined [4.6.1-SCREEN/LM].
4.6.1. Talent selects number of slices from useable data – 200 in this example

5. Volume and Surface Analysis
5.1. To carry out volume and surface analysis in ImageJ [5.1.1-MED OVER SHOULDER], convert the image stack from RooTrak into a binary image format by selecting ‘Process,’ ‘Binary,’ then ‘Make Binary [5.1.2-SCREEN/LM].
5.1.1. Talent at computer opens ImageJ

5.1.2. Talent selects Process, Binary, then Make Binary

5.2. Use the open-source ImageJ plugin, BoneJ to create the triangular mesh by selecting ‘Plugins,’ ‘BoneJ,’ then ‘Isosurface’ [5.2.1-SCREEN/LM].
5.2.1. Talent selects Plugins, BoneJ, then Isosurface

5.3. In the ‘Options’ window that opens up, set ‘Resampling’ and ‘Threshold’ to 6 and 120, respectively.  Then check ‘Show surface,’ and press the OK button [5.3.1-SCREEN/LM].
5.3.1. Talent sets Resampling to 6 and Threshold to 120.  Then talent checks Show surface and presses OK  

5.4. In the ‘3D viewer’ that opens up, click on the File tab, then click ‘Export surfaces,’ and save as ‘STL (binary)’ [5.4.1-SCREEN/LM].
5.4.1. In the 3D viewer, talent clicks on the File tab, then Export surfaces, then saves file as STL binary

5.5. Finally, open imeshJ, load the STL file by clicking ‘Select STL file,’ and enter the voxel size in microns.  Click ‘Enter voxel size’ and enter 31 microns, then click ‘OK’ twice [5.5.1-SCREEN/LM].  
5.5.1. Talent finishes opening imeshJ, selects STL file and enters voxel size in microns then clicks OK twice
5.6. Click ‘Calculate Surface Area’ to acquire the total sample root surface area in mm2.  Then click ‘Calculate Volume’ to obtain the total sample root volume in mm3 [5.6.1-SCREEN/LM].

5.6.1. Talent clicks Calculate Surface Area and points out total sample root surface area; then clicks Calculate Volume and points out total sample root volume

6. Results: X-ray Computed Tomography Data Volume and Surface Analysis of a Three-dimensional Root System
6.1. The specimen, consisting of two stems of the native grass Prairie dropseed, Sporobolus heterolepis, and the original soil around it is shown here. The voxel size of the reconstructed data generated was approximately 31 cubic microns [6.1.1-LM].
6.1.1. LAB MEDIA Figure 1

6.2. After creating a stack of images and increasing the contrast between the roots and soil, the reconstructed data showed that the root and some components of the soil have very similar x-ray attenuation factors resulting in little to no gray-scale contrast in the images [6.2.1-LM].
6.2.1. LAB MEDIA Figure 2, Editor, for the reconstructed data, point out the right hand panel and then the gray areas in the panel.
6.3. This figure shows a representative seed point that was selected inside a pertinent root section visible in the top slice of the volume data [6.3.1-LM].
6.3.1. LAB MEDIA Figure 3, Editor, bring in the top left panel, add in the red box, and then bring in the right zoomed in panel and then finally the bottom panel with the red blob that corresponds to the dark spot in the top panels.
6.4. Using the RooTrak parameters described in this video, RooTrak successfully segmented the selected approximately 200 slices of volume data, which was equivalent to a depth of 6.2 mm [6.4.1-LM].  Segmentation of the root is also demonstrated in this animation [6.4.2-LM].
6.4.1. LAB MEDIA Figure 4
6.4.2. LAB MEDIA Rootvideo.mov, Editor, show time stamp 00:10 – 01:00, may need to speed up.  Place next to 6.4.1 when mentioned if there is enough room.
6.5. Here, ImageJ was used to generate a triangular mesh isosurface of the 3D volume from the data produced by RooTrak. The default settings used produced a detailed isosurface in a relatively quick manner [6.5.1-LM][6.5.2-LM].
6.5.1. LAB MEDIA Figure 5
6.5.2. LAB MEDIA Rootvideo.mov, Editor, show timestamp 01:00 through end, may need to speed up.
6.6. Finally, using imeshJ, the surface area was calculated as 351.87 mm2, and the calculated volume was 47.27 mm3 [6.6.1-LM].
6.6.1. LAB MEDIA Figure 6, Editor, point out each parameter as mentioned.
7. Conclusion (said by authors on camera)
7.1. Tamas Varga: Once mastered, this technique can be done in 5 hours if it is performed properly.

7.2. Tamas Varga: While attempting this procedure, it is important to remember to follow all safety procedures.  It is also important to remember that the root segmentation is only possible if there is sufficient contrast between the root and the soil.
7.3. Tamas Varga Adriana McKinney: Following this procedure, other specimens with a branching structure like tree leaves, animal and human lungs, etc. can be imaged and analyzed in order to answer additional questions like how living tissue grows or is damaged under certain conditions.

7.4. Tamas Varga Adriana McKinney: After its development, this technique paves the way for researchers in the plant science field to explore the drought resistance in model plants, such as Brachypodium.

7.5. Tamas Varga: After watching this video, you should have a good understanding of how to image a plant specimen, visualize its root structure, and extract quantitative information on the root from in-soil x-ray computed tomography data.

7.6. Tamas Varga: Don't forget that working with x-ray instrumentation can be hazardous and the relevant safety procedures should always be followed while performing this procedure.   

Provided Media

Authors, Please list all images, movie files, or 3-D rendered animations that can be included in the video per editor’s request.  The step in the script/video where these images will be inserted should be specified.   For example:

6.2 –  0123_PIname_Figure1.tif -  dual color imaging of tumor angiogenesis at 40X 

6.2 –  0123_PIname_Figure2.tif -  dual color imaging of tumor angiogenesis at 100X

Formats:  For static images we prefer .tiff, .eps, Illustrator, Powerpoint or Photoshop files at dimensions of at least 720X480 pixels and 300 dpi.  The higher resolution, the better.  Likewise any exported movie files should have at minimum these dimensions and be rendered to .mov, .mp4, or .avi files.  

Insert your media filenames here. The files that are already inserted are good, and seem to be correctly located in the script. It may beneficial to break up the file LAB MEDIA Rootvideo.mov (6.4.2) to use as illustration for the various protocol steps as that vide goes from the full tomography data to the root segmentation (tracking), and to the final root image. We also have a longer, slightly altered version of that video (with very striking colors) we could share with you (see: https://www.youtube.com/watch?v=4I-p32ecIC4) to use for the article. Additional images/videos will need to be added from the screen capture material from the screen recording software (not yet recorded).
General Preparation

It’s critical for a smooth and organized shoot that all reagents are accounted for, in advance.   

Any overnight or long incubation steps should be recognized and specimens/samples be prepared in advance so that prior steps can be recorded and shooting can continue with pre-prepared specimens/samples.  

All tubes/flasks should be pre-labeled neatly before we arrive.  

Ex. Luciferase assay done in 96 well plates should be labeled with negative/positive control wells and experimental samples are labeled accordingly.

You will receive more detailed preparation instructions are included in the email accompanying the finalized script.

( 2013, Journal of Visualized Experiments


